Summary: "Critical Path" is defined as: "The longest duration of a set series of activities to a milestone (event) will produce the critical path". The OPDEC Critical Path tool is an add-on to Microsoft Project that displays a graphic representation of up to 5 critical paths and their associated integration points. It provides a quick analysis of the critical paths to Major Milestones in the Integrated Master Schedule (IMS).

Installation and Activation .............................................................................................................................................3
Milestone Professional 2006-2015 Setup ..........................................................................................................................6
Creating a Critical Path Chart .........................................................................................................................................7
Tool Settings ....................................................................................................................................................................7
Chart Creation ................................................................................................................................................................12
Export Milestone Professional files .................................................................................................................................14
Utilizing Milestone Professional Templates ..................................................................................................................16
Column Properties ............................................................................................................................................................17
Symbols and Connectors .................................................................................................................................................17
**Summary:** “Critical Path” is defined as: “The longest duration of a set series of activities to a major event will produce the critical path”. The OPDEC Critical Path tool is an add-on to Microsoft Project that displays a graphic representation of up to 5 critical paths and their associated integration points. It provides a quick analysis of the critical paths to major events in the Integrated Master Schedule (IMS).

**Example:** (Critical Paths 1-5 to Selloff Unit 5”), displays the top 5 critical paths to the event. The legend, (Path 1, Path 2, etc.), shows the float (slack) for each path. The user is now equipped with the required reference points to enable quick analysis of the IMS mapping network.
**Installation and Activation**

Follow the instructions seen while running the installation executable file CriticalPath2016.exe.

Requirements:
  - **2006 Users**: Be sure that you have installed the latest update available from Kidasa. ([www.kidasa.com/download/2006updatedownload.html](http://www.kidasa.com/download/2006updatedownload.html))
- Microsoft Windows 2000/XP/Vista/Win 7

1) Open Microsoft Project
2) Click on “Critical Path” in the OPDEC toolbar or select it from OPDEC tools via the tools menu (Figure 1)

![Figure 1](image-url)
Once you first start-up the Critical Path tool, you will be prompted to activate the software. (Figure 2).

![Figure 2](image-url)
Automatic Activation - If your computer is connected to the Internet, then you can use this easy option.
   i. Click Press this button to activate automatically.
   ii. Enter your name, email, company name, and the serial number that you were issued. Then click OK. (Figure 2a)
   iii. If your firewall prevents this automated action, use the Manual Activation procedure as described below and entered into the registry.

b. Manual Internet Activation - If your computer is connected to the Internet, then you can manually retrieve an Activation Key from the OPDEC web site.
   i. Click Obtain Activation Key via the Internet.
   ii. Your internet browser will launch, automatically go to the OPDEC web site, and display your Activation Key.
   iii. Enter the Activation Key in the Activation Key slot, as shown in Figure 2.
   iv. Press Activate Now.

c. Manual Phone/Email Activation – If the two prior methods of activation are unsuccessful, click Obtain Activation Key via telephone or E-mail.
   i. Send us an email or contact our support desk for more help. (Figure 2b

You may choose Activate Later for 30 days before the software is disabled. For additional help contact our support desk at 256-881-1038 or e-mail us at support@opdec.com.
Milestone Professional 2006-2015 Setup

After installing Milestones Professional, the program option “Run as Multiple Instances for COM/Automation” must be checked. Figure 3a depicts Milestones Professional versions 2006 – 2008, while Figure 3b depicts Milestones Professional versions 2010 – 2015.
Creating a Critical Path Chart

Tool Settings
Before generating a critical path chart, the settings for the tool must be made (Figure 4). Select Tools from the OPDEC Critical Path menu bar and the settings dialog will appear.

1) Milestone Template Location – Default templates are available in the Program Files\OPDEC Tools\Critical Path 2016\Templates directory by default. The templates can be moved to a different location while using the Browse button to specify the new location.

2) Save Location – This is the location where you want all the generated files to be saved to.

3) Text field not used in Project – An empty text field is required for processing. Available options are Text1-30. While the program executes, activities in MS Project that are on the critical path are identified using this field. The critical paths identified by using the slack alone are shown with a value of P1 thru P5. The unique paths (those output to Milestones Professional) are defined with U1-U5.

4) Default number of paths – This setting just saves the value you would most commonly use on the main screen for the number of paths to show in the chart. The process will always use the value on the main form if it differs from the setting.

5) Default Lines Per Page – You may enter a numeric value here to specify the number of lines (rows) on each Milestones Pro page. This can help stretch out compressed charts, but at the
cost of the chart flowing onto multiple pages.

6) Event Identification – Enter the field that uniquely identifies the major events in your schedule. These identified events are crucial for the tool to ensure that they do not impact the critical path (via constraints) unless being measured. Available options are Number1-20 and Text1-30.

7) Target Date Field – Select a date field or specify the target date in which the event must complete by. Available options are Baseline Finish, Date1-10, Deadline, Finish1–10, or user specified.

8) Contract Date – This feature can be used to show a contractual delivery date or something along those lines. Available options are Baseline Finish, Date1-10, Deadline, Finish1–10, or user specified.

9) Contract Date display text – Text used to describe the meaning of the contract date.

10) Prepend Activity Description – Ability to add additional information to the activity description for graphic display. Available options are ID, Number1–20, Text1-30, and Unique ID.

11) Append Activity Value – Select the field that will specify the value you would like to show to the right of each task or event, and these paths will appear in a different pattern. Available options are ID, Number1–20, Text1-30, and Unique ID.

12) Append Title – Enter in text you would like to use as a title for the appended value. For instance, the settings in Figure 4 will display “UID: [123]” in the chart, where [123] is the Unique ID of the task or event.

13) Progress Method – Used to determine how progress will be displayed on the chart. Available options are % Complete, Physical % Complete, Status Date, and user specified Number fields.

14) Use Major Event Field Value as Filename – The final critical path result file will be named according to the value in the Major Event field. If there is no value in the Major Event field and this option is set to "Yes", then the process will use either the Task ID or Unique ID, depending on the Event Field setting on the main form. If running in batch mode (using List Management) and multiple tasks have the same Major Event field value then the result file will be overwritten for each duplicate.

15) Always Show Event as Milestone – This option allows you to toggle how the tool displays the event being measured to. It will either display as a task (bar) if it has duration, or a milestone (diamond) if it does not. You can override this behavior by forcing the event to

Figure 4
always be displayed as a milestone.

16) Display Master Descriptions – Ability to generate a summary report depicting the paths requested, their float, and a brief description of what the problem and cause is.

17) Display Path Detail – Ability to export reports detailing each path's activities

18) Custom Columns – Ability to specify 2 of the columns displayed on the path detail pages. Available options are Number1–20 and Text1-30.

NOTE: Be sure to select “Save Settings” when finished.

Profiles
Starting in version 2011, multiple combinations of settings can be saved and retrieved. The currently selected profile name is displayed at the top of each form. To switch profiles, either select a profile name from the dropdown box on the main form or click the Select button on the Settings form.

To create a new profile:
Enter the desired settings and select Profile >> Save Profile As

To delete a profile
Select Profile >> Delete

Save Settings performs the same function as the Save button. Exit closes the form without saving the changes

<table>
<thead>
<tr>
<th>Profile</th>
<th>Ctrl Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Settings</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Save Profile As</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Delete</td>
<td>Ctrl+D</td>
</tr>
<tr>
<td>Exit</td>
<td>Ctrl+E</td>
</tr>
</tbody>
</table>
Multiple Chart Lists
With the 2016 release, there is additional capability to store lists of tasks or events to create multiple critical path charts in one execution. You may create, edit, and store these lists with the List Management form. Select **Tools >> Manage Lists** from the OPDEC Critical Path menu bar and the list management form will appear.

- **File** – This menu presents you with several options that modify the currently selected list: Create New List, Save, Rename, Delete, and Exit. Create New List will clear out all currently displayed list options and prompt you to enter a new list name. Save will save your current list options. Rename prompts you to enter in a new name for the currently displayed list. Delete removes the current list. Exit will close the form.
• **Settings Profile** – Choose the settings profile you would like to create/edit lists for. Each list of tasks/events is specific to a profile.

• **List** – Select the list you would like to modify. To create an entirely new list, use the File menu.

• **List Type** – Select whether the tasks/events in your list will be determined by a filter with criteria of your choosing, or from a manually entered list of Unique IDs.

• **Filters** - This menu displays all of the filters in the active project. Select one that you would like to use for your list (be sure you have the appropriate List Type selected), and click "Save List" to save your list setting.

• **Unique IDs** - This interface allows you to enter in several unique IDs to comprise your list using the textbox at the top of the frame. Once entered, you will see the task appear in the report below displaying its Unique ID (UID), ID, and Name. You may modify this report by removing individual selections (click the row so that it is highlighted and click "Remove Selected") or by clearing out the list entirely using the "Remove All" button.
Chart Creation

1) Select the Settings profile applicable to the current schedule. See the Tool Settings section for further detail.

2) Enter the critical path you would like to create a chart for. If creating a single chart, use the Event Field and Event options. If creating multiple charts, select which Critical Path List to use. Select the “Not Applicable” list to use the Event Field and Event options; only one may be used at a time.

   a. Critical Path lists come from the List Management form. Please see the above section, Multiple Chart Lists for more information.

   b. To create a single critical path chart, enter the field that contains the event you are going to measure. Options are Unique ID, ID, or the settings default in which case would be the “Event Identification” field specified in the settings (Figure 5). Next, enter the event in which to measure (Unique ID, ID, or Event depending on the previous step).

3) Select the number of paths to display

4) Identify the template to use in creating the critical path chart

5) Click the Run button. The critical path(s) are displayed in Milestone Professional.

6) The chart (Figure 6) can now be modified and/or copied to Microsoft Word or PowerPoint for presentation.

7) Hyperlinks can be selected from each symbol to show further detail for that path. The selection of the target event hyperlink will bring you to a page detailing the top path issues.
8) If the option to display the Master Description Page is selected, then a page is created similar to Figure 7.

9) If the option to display the Detail Pages is selected, then a page for every path is created similar to Figure 8.

10) To run another chart to a different event, simply repeat the process.
Export Milestone Professional files

1) The critical path tool comes with a utility that allows for the exporting of Critical Path charts to a single MS Power Point slide. Each page will become a slide in MS Power Point. In order to get to the export utility interface, click on the “Tools” menu item and then click on the “Export” menu item.

2) The export utility interface has several fields and options to enable exporting of Milestones Professional files to MS Power Point. (Figure 9)

3) Export utility fields and options
   a. Directory – this field is where the export utility will look for Milestone Professional files. This field is defaulted to the save directory specified in the Critical Path settings dialog (Figure 4). The browse button will allow you to select a different directory.
   b. Search Subdirectories – this option allows for the searching of subdirectories. This option will find all Milestone Professional files within the selected directory, not just those files that are directly under the selected directory. This option is not selected as a default.
   c. Find Now – this button will find all Milestone Professional files within the selected directory.
   d. Files listing – this list contains all the Milestone Professional files found. This list can be sorted by filename.
   e. Remove button – this button will remove selected files from the file listing. Files can be selected individually by clicking on the file name. Multiple files can be selected by clicking on a file name, holding the control (Ctrl) button and clicking other files to be selected.
   f. Show/Hide Custom Settings – This menu option will expand (figure 9) the export utility interface to include the Custom Settings area at the bottom of the interface. These settings will dictate the size and position of the image in Power Point.
      i. The **Keyword** column contains fields where the user may enter any unique word or phrase that will be in the Milestones Professional files’ name. Any file name that contains the keyword entered will have the corresponding size and position settings applied to it when the image is exported to PowerPoint.
      ii. The **Horizontal** column should contain how many inches from the left you would like your image placed on the PowerPoint slide. This field should correspond to the "Horizontal" field in the "Size and Position" window of the image in PowerPoint.
      iii. The **Vertical** column should contain how many inches from the top you would like your image placed on the PowerPoint slide. This field should correspond to the "Vertical" field in the "Size and Position" window of the image in PowerPoint.
      iv. The **Height** column should contain the desired height in inches you would like your image to be once the image has been placed in PowerPoint. This field should correspond to the "Height" field in the "Size and Position" window of the image in PowerPoint.
v. The **Width** column should contain the desired width in inches you would like your image to be once the image has been placed in PowerPoint. This field should correspond to the "Width" field in the "Size and Position" window of the image in PowerPoint.

g. Export to PPT – this button will create MS Power Point slides for each file in the file listing. Each page of a Milestone Professional file will become a single MS Power Point slide.
Utilizing Milestone Professional Templates
The Critical Path Tool displays data from MS Project by utilizing Milestones Professional templates. While a default chart template is provided with the tool, it can be configured to display and report various types of information. Some of the more common attributes that are manipulated via the template are as follows:

- Text sizes and placement
- Graphical indicators
- Symbol manipulation (for Gantt charts)
- Introduction of company and/or program logos
- Legend entries
- Row shading
- Much, Much, More

To learn more about utilizing Milestone Professional templates, contact KIDASA software @ 1-800-765-0167 or OPDEC support @ 256-881-1038
Column Properties
To change the data being populated into a templates’ column, double-click the column’s header and then the Column Formatting tab (Figure 10). The automation tag is used by the Critical Path Tool to determine the type of MS Project data that should be populated into it. This tag can be automatically populated by selecting the ‘MS Project field’ dropdown and selecting the field you would like to display. Doing this will automatically populate the automation tag with the appropriate value. In this example, the ‘Baseline Start’ date was selected. Notice that the automation tag shows ‘baselinestart’. This is exactly how the field values needs to be displayed in order for it to be picked up by the tool.

Symbols and Connectors
Connectors and symbols (Figure 11) can be modified within the Milestones Professional personal template. The default template is named “CriticalPath.MTP” and located in your installation directory (default is C:\Program Files\OPDEC Tools\Critical Path).

1) The horizontal symbols and task connectors for non-risk activities can be changed by modifying rows 1-5 from the toolbar
2) The milestone symbols that are used within the 5 paths can be changed by modifying rows 6-10
   a. The status symbol is found on row 8 column 4
   b. The target finish milestone symbol is found on row 9 column 2
   c. The forecast finish milestone symbol is found on row 9 column 4
   d. The contract milestone symbol is found on row 10 column 2
3) The horizontal connector between the target finish and the forecast finish is found at row 9 column 3
4) The horizontal symbols and task connectors for risk activities can be changed by modifying rows 10-14 from the toolbar
5) The vertical connections between the paths can be change by modifying row 17 and row 18 at column 1.

Note: Symbols can also be manipulated to display values being populated within the columns of the chart (regardless if they visible or hidden).
Check Schedule
The Critical Path 2016 tool comes with a utility that will check your schedule file for potential problems that may obstruct the true Critical Path from revealing itself. To use this utility, click on the "Tools" menu item, and select "Check Schedule" from the list to display the Check Schedule user interface (Figure 10).

The checklist that the utility goes through will first appear grayed out. Once the "Run" button is clicked, the utility will enable the items in the list as the utility checks them, turning the text black. The number to the left of each list item references how many issues were found. Optimally, all of these items will have a "0" next to them to indicate that no issues were detected.

![Check Schedule](image)

Figure 10

**Summaries with Pred/Succ** - Indicates the number of summary tasks with a predecessor or successor.

**Multiple Task Calendars** - Indicates the number of task calendars currently utilized. View the "task calendar" field for more information.

**Elapsed Durations/Leads/Lags** - Indicates the number of activities that are using elapsed days/weeks/minutes/etc in the duration field or in leads/lags.

**Sub Projects Inserted** - Indicates the number of sub projects contained within your schedule.

**External Links** - Indicates the number of external links utilized in the schedule.